
  

If you are renaming a file using small icons, there are two additions to the dialogue box. There
will be two switches describing the file's attributes; hidden and locked. You can turn these on and
off simply by clicking the switches, and confirm the choice with OK.

autodd. cod
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You can change a file's name by clicking.
You are also allowed to hide a file or protect it.

THE WASTEBASKET ­ ERASING FILES
Somewhere on the file manager desktop you'll find a trash­can with the legend "Wastebasket"
sitting underneath. This is the final resting place for all of those unwanted, unused and unloved
files, in much the same way that overstressed executives crumple bits of paper into balls and

“launch them into a bin sitting in the corner of their office. If they then discover that what they just
discarded was actually the report their boss wanted today, our fictitious executive can rush over
and rescue it from destruction.

Now, erasing files in File Manager uses the same idea: The files are dragged to the wastebasket,
and remain there until you either decide to empty it (erase the files permanently) or open it (the
files are returned to their source). Both these options are available in the "File" menu, and you can
also open the wastebasket with a double­click.

Dragging a file when it is not the only one selected has the effect of binning all the highlighted
files. (You can put as many files as you want in the wastebasket). You can tell that the bin
contains something because it swells up.

Erasing folders is done in the same way, although (as in DOS) you will not be allowed to bin those
that are either open or contain files. If you try, a suitable message will appear. In the same way,
you cannot erase locked files.

—

Occasionally, when you eject or copy a disc or close File Manager a dialogue box will appear
asking you for confirmation. If the bin contains files, there will be an "Empty Wastebasket" switch
which will do just that unless you turn it off.

There is a short cut for binning the selected files: CNTRL­DELETE

MOVING FILES
It is possible to move files between folders on the same disc by clicking and dragging in much the
same way as files are dumped in the wastebasket. They can be dragged either to another window,
or to the folder's icon (the icon must be in the top window). Of course, folders can also be moved
in this way; there is a safeguard against moving one inside itself, but care must be taken to ensure
that you don't put a folder inside another inside itself!

Like all move operations, all the selected files are moved to the new destination.

COPYING FILES
(In the same way that files are moved between folders on the same disc, you can drag the files to a
window in a different disc to copy them. The files will be copied over any files of the same name
in the other window, so as a safeguard a dialogue box prompts you to confirm the operation.

If you want to copy the files to a disc which isn't open, you can drag them to the icon for the
relevant drive. It isn't possible to copy folders.

COPYING DISCS
Dragging the icon of one disc to that of another (which must be closed) lets you copy the disc.
Since the contents of the target disc will be lost, a dialogue box prompts you to confirm. This is
equivalent to MasterDOS's BACKUP command.

EJECTING (CLOSING) DISCS
Since you can only fit one disc at a time into a disc drive, you have to eject one floppy before you
can open another. You can do this by dragging the open disc to the wastebasket, or by closing the
window corresponding to the disc. In either case, you will be prompted to confirm and (as I
mentioned earlier) empty the wastebasket.

Once a disc has been closed, all its windows are also closed and removed from the screen.

ERASING RAMDISCS
You can erase a ramdisc from memory (losing everything in it) by dragging its icon to the
watebasket, or by selecting it and choosing the "Erase Ramdisc" option from the "Device" menu.
(The ramdisc must be closed.) You will be prompted to confirm the action.
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CREATING FOLDERS
You can create a folder in the current window from the options in the "File" menu. Simply enter
its name. When you open the folder for the first time (this also applies to any sub directories you
created before you got Driver), it will fill the whole screen; you will have to give it a size and a
position. As with renaming files, you can enter a full pathname for the folder.

CREATING BOOTSTRAPS
You've probably got quite a few SAM applications already; most of them will run from a BASIC
program with a bit of machine code. Well, you could open the files from Driver, but this would be
a bit fiddly, the icons wouldn't represent the program, and Driver would stay in memory ­ this
might cause problems since most SAM applications don't manage their memory properly.

To solve these problems, File Manager offers a new file type: the Application Bootstrap. (It's
called a bootstrap because it's tied to the application.) This is a small file that contains an icon and
the name of a BASIC program to open when you double­click the bootstrap.

To create a bootstrap you need two things: The icon and the program. The former can be created
using the Icon Master application, or taken from the selection supplied on your disc. I can't help
with the latter, I'm afraid.

The "Create bootstrap" option opens up a dialogue box with three text boxes and three buttons. At
the top you can enter the bootstrap's name, below that the name of the icon file and, at the bottom,
the name of the BASIC program. Full pathnames are accepted, but any drives you refer to must be
open. (eg. you can have the icon on a different disc, but it must be in an open drive.)

There is also a switch which lets you add a setting to the bootstrap. If the switch is put on, opening
the bootstrap will also close Driver (just like closing the Driver Desktop). This lets you use the
File Manager as a launcher for applications which won't run with Driver in memory.

The first two buttons (OK and CANCEL) are self­explanatory. The last, "VIEW ICON" lets you
have a look at the icon you have named. I would suggest that you put all the files belonging to the
application in a seperate folder, and specify that in the pathname for the program.

FORMATTING DISCS.
The last menu option (in the "Device" menu) lets you format both floppies and RAMdiscs. Firstly,
specify the drive (unavailable drives are faded and cannot be selected) and click "CONTINUE".
The next box lets you choose the disc's name, its size (in tracks) and the size of its directory
(again, in tracks). I would advise you to refer to the MasterDOS manual for an explanation of disc
formatting.

The OK and CANCEL buttons do what you would expect; the "BACK" button lets you return to
the previous box to change your mind.
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ERROR MESSAGES
In File Manager, two types of error can occur. The first type is not serious, and normally takes the
form of a message in a dialogue box with a CONTINUE button.

The second type are given to Driver by the DOS. These are much more urgent: "Disc write
protected", "Sector error” and so on. In situations like this, a dialogue box is opened with the
relevant message, and three buttons:­

{ RETRY | lets you try the disc operation again, after write­enabling the disc, for example.

{ IGNORE J or will forget about the disc operation and continue with the File

File =e) It doesn't affect other Driver applications.

You can also reset File Manager during normal operation by pressing CNTRL and ESC together.

| cacere @ Fouoer
4 New nane New Folder } gdss Lich
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Wado: ced —= of The disk is write protected.
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An urgent DOS error.
Here you could write­enable the disc and click to RE­TRY the operation.
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6: NOTEPAD
PEa]

Notepad is a word­processing Driver application that you will find on your disc. To open it from
File Manager, double click on the icon.

If you have never used a word­processor before, you should be aware that it allows you to create
text documents like a type­writer, except that the text appears on the screen. You can also edit and
change bits of the text without needing to reach for the Tipp­Ex! The document can be saved to
disc for later use, and you can produce a hard copy of it on a printer.

Notepad differs slightly from most other SAM word processors in a number of ways. Firstly, the
screen is 80­characters wide instead of 64. (This lets you use the full width of most printers using
10 cpi, characters­per­inch).

The only restriction to the size of your document is available memory. (You can see how much
memory is being used by the program from the "About Notepad" option in the "Driver" menu. The
size quoted includes 32768 bytes for the program itself).

ART FIVE. NOTEPAD, |

jer RaRept that the tex

The NOTEPAD application.
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SCREEN SET UP
At the top of the screen you'll see the application's name, the close gadget, and the menu list.

Below that is a window for the file you're currently editing with its name. (This will be "untitled"
if you haven't given it a name). The text is displayed in the middle with a flashing cursor, and
there is a scroll bar to the right.

At the very bottom of the screen you'll see the "tab bar", more of which later, and a credit for the
software producers.

ENTERING TEXT
Text and other characters can be entered at the cursor using the keyboard. As you enter text, space
is made for it automatically so there is no need to worry about pushing things out of the way.

Indeed, as you type, the lines of text are wrapped around the window automatically to avoid words
being split up. The program does this by adding a "soft return" to the end of every line, and these
sort returns are continuously updated as the text is changed.

There is another way of ending lines, the "hard return". This is a code that you place into the file
using the [RETURN] key, and it forces the next character to start on the next line. Hard returns
can be added, moved and deleted like any other characters, although they are invisible.

In a similar way, "tabs" can be inserted into the text using the [TAB] key. A tab is also a code that
is placed in the file, but instead of moving the next character a line down, it moves it along to the
next tab position. The positions are marked in the tab bar mentioned earlier, below the text
window.

You can move the cursor around using the cursor keys at the bottom right of the keyboard.
Holding down [SHIFT] with left or right will skip over a word in that direction.

Alternatively, you can position the cursor by moving the pointer and clicking. When you type
something the pointer disappears, but it will return as soon as you need it.
[DELETE] removes the character to the left, pressing [SHIFT] and [DELETE] together removes
the one to the right.

If you are using keyboard control for the pointer, you must press [SYMBOL] and [EDIT] together
to "toggle" between this and using the keyboard for the cursor/entering text.

THE SCROLL­BAR
The scroll­bar to the right represents the whole document, with the square indicating the part of
the document currently displayed. You can move the display up or down a line by clicking on the
arrows at either end of the bar, and up or down a page by clicking on the bar above/below the
square.

Alternatively, click the square itself and drag it to a new position. This lets you move around the
document quickly and easily.

You can also move up/ down a page with CNTRL­UP and CNTRL­DOWN.
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SELECTING TEXT
To select a section of text, simply point to the the start, click, then hold down the mouse button
and drag the pointer to the end. Releasing the button completes the selection.

You can replace the selected text with anything else that you type, or erase it by pressing
[DELETE].

You can also cut out the text and place it on the clipboard using the "Cut" option in the "Edit"
menu. "Copy" does the same thing, but leaves the text intact. The short­cut keys for both these
options are CNTRL­X and CNTRL­C respectively. See Part Two of this manual for information
about the clipboard.

There is a quick way of selecting the whole file using the "Select All" option. CNTRL­A does the
same thing.

To deselect the text, simply position the cursor by clicking or using a cursor key.

.

Motepad differs slightly from other SAM word processors in 3 number of ways.
Firstly, the screen is 80­characters wide instead of 64. (This lets You use the
full width of most printers using 18 cpi, characters=per­inchi.

ction to the size of your document i% available memory. {You can
f y i% being used by the program from the "About Notepad" option
r" menu. The size quoted includes 32782 byte: for the program

Sections of text are selected by clicking and dragging.

PASTING
Once there is some text on the clipboard, you can paste it in at the cursor using the "Paste" option
in the "Edit" menu, or by pressing CNTRL­V. If you would like to leave a copy of it on the
clipboard for further use, you can choose "Multiple Paste" instead (CNTRL­M).

You can only paste text into Notepad, and anything else on the clipboard is ignored.
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FILE OPERATIONS
To start a new file choose "New" (CNTRL­N) from the "File" menu. If you have made changes to
the existing file without saving it, you will be asked if you wish to save the changes.
You can open a new file with the "Open" option (CNTRL­0). A dialogue box appears with a text
box into which you can type the file name.
Below that, there are two "scroll boxes" with, on the left, a list of files and, on the right, a list of
folders (and discs). You can move the lists up and down a line using the scroll arrows, or up/down
five lines by clicking above or below the square indicator.
To select a file, click it once. The file name appears in the text box and is also highlighted in the
list. Clicking it again will open it; alternatively, you could click the OK button. You can open a
folder (or a disc) in a similar way, by clicking its name twice.
It is possible to force Notepad to "mask out" certain files by entering a file name with "wildcards"
into the text box. Use a question mark "?" to represent any single character, and an asterix "*" to
represent a series of characters. If you are unfamiliar with wildcards, I suggest you consult your
MasterDOS manual.

As I mentioned, there are OK and CANCEL buttons which do just what you'd expect.
Saving files involves a similar process. The option "Save as" lets you save the file under a
different name, in a different folder or on a different disc. It opens up a dialogue box, and all the
above instructions apply. Protected files are displayed faded, you are not allowed to use those
names. If you only wish to save the same file, in the same folder, to the same disc you can use the
"Save" option (CNTRL­S).

provides 3
ion

Program,
Files­­ Folders ­­

manual [11 i 5
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Opening a file.
Below the text box, available files and folders are listed in scroll boxes.
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USING THE 64­COLUMN FILE FORMAT
As mentioned previously, most other SAM word processors use a different file format to
Notepad's; if you try to open such a file, you will be asked if you want to convert it. In addition to
conversion from 64­column format, any unrecognised control codes will be stripped out.

The same query is made for every file Notepad doesn't recognise. It might be that the file IS
compatible (most PC files should be, for example), in which case you should choose CANCEL.

You can also do the same thing in reverse, by choosing "Convert" from the "File" menu. This
(after asking you to confirm) will convert the file to 64­column format and then lets you save it
under a different name. The converted file will load into the other SAM word processors provided
it is not too big.

PRINTING THE DOCUMENT
You can make a hard copy of the document by choosing "Print" from the "File" menu (CNTRL­P).
This opens a dialogue box with a number of features:­

PRINT and CANCEL let you proceed or forget about printing.

You can choose "Draft" or "Final" quality, bearing in mind that "Final" takes longer.

All the pages can be printed, or a range of pages can be specified.

"Page length" lets you change the number of lines printed on each page.

If you are using continous (fan­fold) paper, you might want to print a number of blank lines at the
end of every page to skip over the perforation. This can be entered as the "Top/ bottom margin."

There is also the option of printing a header at the top of each page (the text message you enter
will be centred), and a footer (using the page number) at the bottom. Each adds three lines to the
page length.

Finally, there is an option to add line feed codes to the end ofeach line. Your printer might add
them itself, in which case this should be turned off.

CHANGING TABS
As | mentioned previously, the tab positions are represented at the bottom of the text window. You
can add a tab to the bar by positioning the pointer and clicking. By clicking on an existing tab you
can drag it around and move it to a new position on the bar. You can delete the tab by dragging it
off the bar.

A file's tab positions are saved with the text.

CHANGING FONT
There are two typefaces you can use for the document ­ Times Roman (the default) and Courier.
Courier uses larger characters, but leads to a more cramped display. You cannot mix the two.
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7: ICON MASTER

The next application, Icon Master, lets you create the icons that :
bootstraps. are used by File Manager to create

Icon Master.

SCREEN SET UP
Apart from the normal application desktop, there are three windows on the i: 5 screen. The middleshows an expanded image of the icon while a normal sized image is shown in another Bincow tothe right. To the top right is a third window, the Palette, which contains four pots of paint. Thecolour corresponding to the left mouse button is marked "L" and for the right button "R".

CHOOSING COLOURS
To allocate a colour to either button, simply point to the i i: pot and click with the relevant buttonAlternatively, [FO]­[F3] will allocate colour for the right button, and holding do HIFT] wi
[FO]­[F3] does the same for the left. : alii
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EDITING THE ICON
To set the colour of a pixel, move the pointer to the position in the expanded window and click

with left or right. The relevant colour will be used.

FILE OPERATIONS
You can start a new file with "New" (CNTRL­N) in the "File" menu. The other options allow you
to open a file (CNTRL­O), save the icon (CNTRL­S) or save it under a different name. For details

on using the open and save dialogue boxes, see Chapter 6 on Notepad.

There is a selection of prepared icons in the "Icons" folder on your disc.

SPECIAL FUNCTIONS
The edit menu contains four options to manipulate the image:­

Undo (CNTRL­U) ­ Undoes the last thing you did.

Clear (CNTRL­W) ­ Fills the whole image with the left button colour.

Mirror Horizontal (CNTRL­H) ­ Mirrors the icon about an axis down its centre.

Mirror Vertical (CNTRL­V) ­ Mirrors the icon about an axis across its centre.
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8: PREFERENCES
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Now, even though I have attempted to make Driver as friend! j imig it ti iy r endly and enjoyable as possible, most

"I don't like the colour."
" want my cursor to flash faster."

y Have you got it in strawberry flavour?"

So to provide for those of you who are fickle, there is another applicati; » icati
alter such settings. (Apart from the flavour). app: on program that lets you

i P ng lets you create files, which you can use to automatically customise Driver as soon as it
loads.

1
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Preferences.

SCREEN SET UP
First, there is the application desktop window, wiBt. Then there are four windows. P Ww, with the name of the current file below the menu



  

Colours.
Four horizontal bars, similar to scroll bars, indicate the colour in each palette pot. You can change
the colour by clicking in the relevant position on the bar, or by using the arrows at either end
(although the former gives greater accuracy).

Windows.
You can choose which of the four colours is used for window frames, and the pen and paper for
window names.

Menus.
You can change the pen and paper colours for the menu list.

Timing.
You can select the delays required for a double­click, for dragging and between flashes of the
cursor. Times, measured in 50ths of a second, are changed in the same way as the palette above.

FILE MANAGER OPTIONS
Several file manager settings can also be envoked from here: "Sorting", "File Types", "Small
Icons", "Align Filenames" and "Show Hidden Files". Please refer to File Manager's instructions for
more information on these settings.

There is one setting which cannot be changed directly in File Manager. When you copy 2 file, it is
automatically copied over any file of the same name. You can de­activate this feature with "Copy
OVER" in the "Options" menu. You will then be prompted by the DOS every time you copy.

DRIVER OPTIONS.
In addition to customising File Manager, four more settings are found in the "Options" menu. The
first, "Automatic Capitals" will force all text printed by Driver (although not in things like
Notepad) into upper case.

The final three control what happens when you load Driver for the first time. It is possible to
return straight back to Basic, automatically open File Manager and/or open the disc in drive 1.
Any combination of the three is possible.

FILE OPERATIONS.
The usual Open, Save and Save as options are covered (refer to the Notepad instructions) as well
as "Reset" which will return all the settings to the state when Preferences was first opened.
CNTRL­R will do the same thing; if you've been silly and messed up the colours so that the
dialogue box is invisible, you can still confirm with CNTRL­RETURN.

There are sample files on your disc in the "Settings" folder. In addition there is a "Driv??2.set" file
(the question marks refer to a version number) which is loaded with Driver to initialise the
settings, and you can customise this to your own liking. It is worth noting that, although not
directly changed by Preferences, the default positions and sizes of the windows for drives 1 to 7
are also stored in settings files.

­

9: DRIVER TUTORIAL

To help you get to grips with the Driver WIMP environment, you'll find another application
program on your disc; the Driver Tutorial.

All the instructions are provided in the program, which will lead you through windows, menus and
dialogue boxes. Simply click CONTINUE in each window to progress.

man you for Hiuing Driver. THiS tutoridl program is designed
guide dou through its variels featuces.

Frou can select an obscured window by ct icking it. Try this

The Driver Tutorial.
A quick way to get to know the Driver system.
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10: CALCULATOR

This is a "desk accessory", a small application program that you can use as a tool whilst working
on other documents. For example, if you are creating a file using Notepad, and you require the
result of some arithmetic operation, you can switch to Calculator and then back again.

On top of the application desktop there is another window with a move gadget, inside which you'll
find the calculator's "buttons" and a display for the results.

Using The Calculator
You can use this as. you would a normal calculator, but instead of pressing keys you can point to
the relevant "button" in the window and click. There are buttons for the digits 0­9, a decimal point,
the four operations (add, subtract, multiply and divide ­ the slash symbol "/" is used), an "equals"
to produce the result and a final button for clearing the display.

The Calculator application.

Alternatively, pressing the keys 0­9 or the function keys FO­F9 produces the same effect as
clicking a digit. You can also use the [+], [­], [*], [/] and [=] keys if you want.

[RETURN] mimicks equals, and [DELETE] will do the same job as the clear button.

32

11: SLIDEY PUZZLE

Finally, to provide some light relief from the stains of word­processing documents or designing
icons, you'll be delighted to find a puzzle game on the disc.

THE GAME
Slidey Puzzle is a version of the age­old puzzle using a picture divided into tiles which can be slid
up, down, left and right. The picture is shuffled around by the computer and your aim is to
re­arrange it.

The puzzle itself fits into a moveable window on top of the application desktop.

Moving A Tile
To push a tile into the space, simply click the tile. It will be moved automatically.

Alternatively, you can use the keys [Q], [A], [0] and [P] to push a tile up, down, left or right
respectively. You might prefer this if you are controlling the pointer using the keyboard.

"The Siidey Puzzle
A little light refreshment ­ to be taken at least once in a while.
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Options
You can start again using "New" in the "Options" menu (or CNTRL­N). Underneath this, there is
an option "Show Randomisation” (CNTRL­R) which is normally on and lets you see the computer
shuffling the tiles.

There are four levels of difficulty "Easy", "Medium", "Difficult and "Triltex!". The last is a rather
poor attempt at humour by the author, who also wrote that particular award­winning puzzle game.
The difficulty levels can also be changed using [CNTRL] with [1] to [4].

Piccy
The "Piccy” menu gives the choice from four mouth­watering examples of artistic genius. Or
something like that. The four pictures are "Numbers", "Letters", "Smiley" and "Star" and can also
be selected using CNTRL­5 to 8 (others may be provided in future versions if we get sent some
interesting ones by our users).

a
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12: TECHNICAL INFORMATION

Driver consists of four files:­

"Driv??.cod" The main code, 32k long.

"Driv??.dat" Graphics and other data, 16k.

"Driv??.set" Initialisation settings. (See Preferences)

"Auto??.cod" The auto­loader.

The question marks refer to a version number (for example, "Drivl0.cod" is version 1.0;
"Driv11.cod" would be version 1.1).

When the disc is booted, the auto­loader loads itself temporarily into a buffer and looks for
memory. It requires two consecutive 16k pages for the main code and another one for the data, all
in internal memory.

It also sets up the new keyword "DRIVER", using about 128 bytes in the System Heap. If there is
not enough memory available for either that, or for the Driver code and data, it will respond with a
"No memory" error.

If there is, the code is loaded, the keyword set up and Driver is run. Exactly what happens then
depends on certain preference settings (see Preferences).

The keyword uses token 208, and is disabled when Driver is closed. Two system variables at
23703 and 23704 hold the page numbers for Driver and the data respectively.

It is possible to run Driver without the keyword, and you might want to do this if you use the
System Heap for some other purpose, although if you use correct memory management protocol it
shouldn't be a problem. Simply POKE 23703 and 23704 with the page numbers and load the
Driver code and graphics in. 3

The following lines should help:­

LET pl=20,p2=22: REM Page numbers.
POKE 23703,pl1,p2
LET a=pl*16384+16384: REM Start address of Driver code.
CALL a+3: REM First call to initialise.

Subsequently, to run Driver use "CALL a" instead of "DRIVER".

Driver allocates memory using the protocol mentioned earlier, and entries in ALLOCT use 224 for
Driver code and data pages, 225 for applications, 237 for application data and 236 for clipboard
pages. Entries are also made in MasterDOS's external RAM table; external RAM is used instead of
internal memory wherever possible.

If you like, you can change the name of the "Auto??.cod” file, and have a BASIC "Auto*" file
instead. For example, let us change it to "Load10.cod” with the following BASIC program called
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"Autoload".

10 LOAD "font.chr" CODE UDG" ": REM Load BASIC character set.
20 LPRINT CLEAR 16384: REM Initialise print buffer [MasterBasic only]

30 DEF KEYCODE 199,CHR$ 208: REM Define F7 as “DRIVER (RETURN) ".
40 FORMAT "D3",4,160: REM Set up RAM disc.
50 LOAD "Loadl0.cod" CODE: REM Load and run Driver.
60 NEW: REM Get rid of program as soon as Driver returns to Basic.

You could always put the Driver files, together with the DOS and other system files into another
folder (say, "System") and use

5 DIR ="\System"

at the start of the Basic auto loader.

Driver is compatible with MasterBASIC's interrupt­printer, and (for example) Notepad outputs
through channel "B", so that you can print something out while working on another document,
provided you have MasterBASIC.

You will have been aware of the "memory management protocol” I keep mentioning. More
information on this is available in various technical documentation for the SAM and MasterDOS.
However, if you wish to run a BASIC/ machine code application the following guidelines should
ensure compatibility with Driver:­

Reserve memory up to the last 16k page with OPEN TO n. Then use CLEAR xxx to set RAMTOP
between the BASIC program and the code. Make sure that other memory, such as the screen, is
also reserved. (For example, by using OPEN SCREEN).

Some programs use memory at 16384 (the System Heap) without reserving it. This will cause
Driver to crash if you load it with the keyword (see above). The MasterBASIC function

RESERVED might help in such cases.

FILE MANAGER
There are two new file types:­

22 Driver application

23 Application bootstrap

Any file of either type will appear in a MasterDOS directory as "WHAT?", but you can still
perform normal file operations on them. The icon for each is stored 256 bytes into the file, and is
192 bytes long (16x24 "fat" pixels).

The first byte in a bootstrap is the "Close Driver" flag; the Basic file.name follows and ends with
FFh. Thus, the total length of a bootstrap file is 448 bytes (plus a nine­byte header) and it all fits
nicely in one sector.

The positions and sizes of folders' windows are stored in their directory entries:­

Byte 232 x­coordinate
233 y­coordinate
234 x­size
235 y­size

These correspond to bytes 27­30 in the file's UFIA.
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NOTEPAD
Notepad uses a file format foreign to most other SAM word processors: instead of padding out
lines with spaces to give 64 characters per line, it uses "hard" carriage returns (ASCII 13). This
format can lead to slightly slower file editing, but is more efficient and I believe it makes editing
the file easier. It should also let future Driver word processors use Notepad files.

In addition, you can open most text files created on other computers, particularly PCs. (Such word
processors tend to use hard returns). If you try to open one of these files, and are asked if you want
to convert it, respond with "CANCEL". Otherwise you'll convert the file into gibberish! However,
any unrecognised character codes will be left in, and represented as little squares.

Tabs are entered into the file using code CHRS 9: the Epson tab code, compared to the SAM's
usual value of CHRS$ 6. The settings for the tab positions also use Epson codes (CHR$ 27, CHRS
68, tabl, tab2, tab3... CHRS$ 0) and are saved at the start of the file, and at the start of any text on
the clipboard. However, to increase processing speed, the code sequence is prefixed by CHRS 1,
with CHRS$ 2 between the codes and finally ends with CHRS 3.

For example, with three tabs at columns 16, 38 and 55 the Epson codes are:­

27, 68, 16, 38, 55,0

This is stored as:­

1,27,2,44,2, 16,2, 38,2, 55,2,0, 3.

Although this system might seem a little redundant (Notepad could do without it) it is designed for
the use of other applications.

Driver allocates memory in 16k pages, but the Notepad document is stored in blocks which are
balanced at a level of 15.75k, leaving a 256 byte buffer. This means that, normally, editing the file
does not involve inter­page manipulation, and helps to improve speed. The total amount of
memory reserved by the application (including 32k for the program) is shown in the "About
Notepad" dialogue box.

PREFERENCES
A preferences file is copied into the main Driver code, at an offset which can be found 26 bytes in.
For example, to load a settings file, use the following:­

100 LET base=16384+16384*PEEK 23703: REM Driver code address
110 LET a=base+DPEEK(base+26): REM Settings address
120 LOAD "filename" CODE a

This address is at the end of the Driver code, to ensure compatibility with any future versions.
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13: COPYRIGHT & SUPPORT
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This manual and the program disc it describes are the copyright property of Revelation Software

and is protected by both British and International law.

To sell or give­away copies of this manual or program disc or contents thereof, whether in whole
or in part, without the written permission of the publisher is a criminal offence punishable by

heavy fines and/or prison sentences. Each copy of the program disc carries an electronic
watermark to enable us to trace illegal copies back to the purchaser.

Revelation Software permits you to make two (2) working copies of the program disc for your
own personal use. In fact we encourage you to do this as soon as you can after buying this package
(we even provide labels for your discs) ­ that way you can keep the original master disc in a safe

place (away from heat, dust and magnetic fields) so you can always go back to it should you
corrupt your working copies. However, if at any time you should sell, or otherwise part with, the
original disc and/or manual then you MUST, without further delay, erase ALL copies of the
program in your possession or control. Failure to do this is a‘breach of copyright as defined above.

This software should also be treated like a book. This means that only one person should use this
software at any one time and on only one machine. You could have a working copy on your
computer in the office and keep another at home for use in the evening but you should not allow
someone to use the home copy while you are at work using the office copy, or vise­versa. For
business and educational users a site license is available which will allow for more than one user,
please write to Revelation Software for details.

Revelation Software is committed to producing value for money software for the SAM range of

computers ­ we can only do this if we pursue copyright infringement with the full force of the law.
Please obey the rules ­ then we all benefit.

COPYRIGHT © 1993 REVELATION SOFTWARE

All Rights Reserved

Driver was devised and written by Steve Taylor. Software direction by FRED Publishing.

Revelation Software, PO Box 114, Exeter, Devon, EX4 1YY, England.

WARRANTY

Revelation Software or the national distributor (address provided below) warrants the disc (or
tape) on which this product is furnished to be free from defects in materials and workmanship
under normal use for a period of sixty (60) days from the date of delivery to the first purchaser. If
failure of any disc or tape has resulted from accident, abuse or misapplication, neither Revelation
Software or its national distributor shall have any responsibility to replace the disc or tape. Any
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replacement disc or tape will be warranted for the remainder of the original warranty period or for
a period of thirty (30) days, whichever is the longer. You are strongly advised to make working
copies of the software and to keep the original disc in a safe place.

Should your original disc become unreadable outside this warranty period then Revelation
Software will be pleased to provide a replacement at nominal cost ­ please write to us for details.

PROBLEMS?
If you ever encounter any problems with this program then contact either us, at the address given
on the previous page, or your national distributor (see below). Before taking any actions please
make sure that your hardware is in perfect working condition and look through this User's Guide
to see if an immediate answer is available. The response to your problem will depend upon the
accuracy of the error description you provide. Your letter should contain at least the following
information:­

= Driver version number

= Type of computer and any kind of extra hardware including driver software etc. because it
might interfere with Driver.

= A detailed description of the problem, please include a printout or preferably a file on a disc
to illustrate the problem.

* A stamped envelope with your own address so we can give you an answer, ask for more
detailed information if needed, or return any discs you send.

DISCLAIMER
Except as expressly provided above, this product, disc (or tape) and documentation are provided "as is". Revelation

Software and/or the author make no warranty or claim of any kind, either expressed or implied, as to the fitness of the
product for any particular purpose.

Revelation Software, and any national distributor listed below, shall not be liable for any direct, indirect,

consequential or incidental damages (including damages from loss of business profits, loss of business or commercial

information, and the like) arising out of the use of or inability to use this product.

While every effort has been made to ensure the accuracy of information printed in this manual the publishers will not
be liable for any errors or omissions that may have occurred.

The publisher will attempt to keep this product compatible with any new versions of the machines or disc operating
systems supported. However, the publisher cannot promise that existing versions will always work on future
hardware. A policy of continued development of the software means that the publisher will only be able to support the
current version of the program outside of the sixty day limit given in the first paragraph.
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14: YOUR NOTES
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This page has been left for you to write your own notes on.


